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RX65N Group 
Visualizing and Controlling Sensor Information Using Amazon Web Services 
with RX65N Cloud Kit and FreeRTOS 
Introduction 
This document describes a system that uses the RX65N Cloud Kit board from Renesas. This system 
incorporates the RX65N running Amazon FreeRTOS and via a Wi-Fi connection visualizes (light) sensor 
information on Amazon Web Services (AWS) and controls LEDs on the board using the AWS shadow 
service. 

Amazon FreeRTOS is a realtime operating system that enhances the FreeRTOS kernel with functionality for 
connections, security, and over-the-air (OTA) updates. It includes demo applications for demonstrating the 
functionality of Amazon FreeRTOS. 

e2 studio is a development environment based on the open-source Eclipse CDT (C/C++ Development 
Tooling) project. In addition to a debugging interface, it provides support for building projects (editor, 
compiler, linker control). It also supports integration of Amazon FreeRTOS demo applications, enabling them 
to run on Renesas evaluation boards.  

Note: The Amazon Elasticsearch service is scheduled to be renamed the Amazon OpenSearch service, but 
the name Amazon Elasticsearch service is used in the descriptions in this document. 

 

Purpose of This Document 
This document explains in an easy-to-understand manner the procedure for connecting and controlling AWS 
using an Amazon FreeRTOS demo application (from connecting to AWS to running the demo). 

 

Operating Environment 
Operation on the following environment has been confirmed. 

Integrated development environment e2 studio 2021-04 
Board RX65N Cloud Kit 
Toolchain CC-RX Compiler v3.03 

GCC for Renesas RX 8.3.0.202004 
Emulator E2 emulator Lite (on-board) 

 
Visit the following webpage for information on boards, related programs, and development environments 
needed for development work using RX cloud solutions. 

https://www.renesas.com/rx-cloud 

 

Related Document 
RX Family Troubleshooting when Using Amazon Web Services (R20AN0624) 

 

https://www.renesas.com/rx-cloud
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Notes:  
• AWS™ is a trademark of Amazon.com, Inc. or its affiliates.  

(https://aws.amazon.com/trademark-guidelines/) 
• FreeRTOS™ is a trademark of Amazon Web Services, Inc. (https://freertos.org/copyright.html) 
• GitHub® is a trademark of GitHub, Inc. (https://github.com/logos) 
• Pmod is a trademark of Digilent Inc. (https://store.digilentinc.com/) 
 
 

https://aws.amazon.com/trademark-guidelines/
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1. Terms 
Terms used in this document are explained below. 

 
Table 1.1   Terms 

Term Meaning 
AWS Amazon Web Service 
shadow Used to store and retrieve information on the current status of a device. 
Amazon Elastic Service A managed service for deploying, manipulating, and scaling AWS clusters 

in the Elasticsearch cloud. 
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2. Preparation 
This document describes the process from importing the project to running the demo using RX65N Cloud Kit. 

 

2.1 Hardware Configuration 
The hardware configuration of the demo project is listed in the table below. 

 
Table 2.1   Hardware Configuration 

Item Content Provider Description 
Board used 
(packaged with 
RX65N Cloud Kit) 

Target board for 
RX65N 

Renesas 
Electronics 
Corporation 

Evaluation board mounted with RX65N 
MCU*1 

RX cloud option 
board 

Cloud communication evaluation board 
capable of connecting to AWS*1 

Silex Pmod module Communication board mounted with 
wireless LAN module*1 

Wi-Fi Wireless router  Wireless LAN standard: IEEE 802.11b/g/n 
(2.4 GHz) 
Encryption method: ES 

PC Windows 10  Recommended OS 
Google Chrome  Web browser used 

Note: 1. The target board for RX65N, RX65N cloud option board, and Silex Pmod module are included in 
RX65N Cloud Kit. 

 
 

2.2 Software Configuration 
The software configuration of the demo project is listed in the table below. 

 
Table 2.2   Software Configuration 

Item Content Version 
Integrated development environment e2 studio 2021-04 
Compiler CC-RX V3.03 

GCC for Renesas RX 8.3.0.202004 
Communication software Tera Term Version 4.71 
Emulator E2 emulator Lite (on-board)  

 
To secure sufficient heap area for the application, change the value of the BSP_CFG_HEAP_BYTES macro 
in r_bsp_config.h from 0x400 to 0x1000. 
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2.3 Tera Term Settings 
The Tera Term settings for the demo project are listed in the table below. 

 
Table 2.3   Tera Term Settings 

Item Setting 
Baud rate 115,200 
Data length 8 bits 
Parity none 
Stop bits 1 bit 
Flow control none 
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3. System Diagram 
The system diagram below shows the steps from the acquisition of light sensor information to visualization, 
and the use of the shadow service to control RX65N Cloud Kit. 

 

Figure 3.1   System Diagram of Steps from Acquisition of Sensor Information to Visualization 
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4. Connecting to AWS 
The following preparation is necessary in order to connect RX65N Cloud Kit to AWS. 

 

4.1 AWS Preparation 
Refer to the tutorial below and make AWS settings. 

 
Register device to AWS IoT 

Link: https://github.com/renesas/amazon-freertos/wiki/Register-device-to-AWS-IoT 

Note:  Complete the steps up to “Check AWS IoT endpoints.”  
 

https://github.com/renesas/amazon-freertos/wiki/Register-device-to-AWS-IoT
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4.2 Hardware Preparation 
Follow the steps below to prepare the hardware for the demo program. 

 
1.  Remove the jumper from the EJ2 pins on the target board (bottom board). 
2.  Connect the ECN1 connector on the target board (bottom board) to the PC via a USB cable.  
3.  Connect the CN18 connector on the cloud option board (top board) to the PC via a USB cable.  
 

 

Figure 4.1   RX65N Cloud Kit (Top) 

 

 

Figure 4.2   RX65N Cloud Kit (Bottom) 
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4.3 Software Preparation 
Follow the steps below to prepare the software for the demo program. 

 
1. Extract the project files from the archive and copy them to a suitable location. (In the description below, 

the root folder containing the project files is designated as ${base_folder}.) 
 

Note:  After extracting the project files from the archive, copy them to a location with a short file path, 
such as the root folder on the C: drive. If the file path is too long, a build error may result.  

 
2. Launch e2 studio and specify a workspace directory. 

 

Figure 4.3   Workspace Selection Menu 
 
3. Select File → Import…. 

 

Figure 4.4   File → Import… 
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4. Click General → Existing Projects into Workspace → Next >. 

 

Figure 4.5   General → Existing Projects into Workspace → Next > 
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5. Click Browse…, then specify the root directory as follows. 
 ${base_folder}\projects\renesas\rx65n-cloud-kit-uart-sx-ulpgn\e2studio\aws_demos 

(When using CC-RX as the compiler) 
 ${base_folder}\projects\renesas\rx65n-cloud-kit-uart-sx-ulpgn\e2studio-gcc\aws_demos 

(When using GCC for Renesas RX as the compiler) 
Finally, click Finish. 

 
Note: Make sure Copy projects into workspace is unchecked.  

 

Figure 4.6   General → Existing Projects into Workspace → Next > 
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6. Define the following four macros in ${base_folder}\demos\include\aws_clientcredential.h. 
 clientcredentialMQTT_BROKER_ENDPOINT  

→ The name of the endpoint confirmed as described in 4.1, AWS Preparation. 
 clientcredentialIOT_THING_NAME  

→ The name of the thing registered as described in 4.1, AWS Preparation. 
 clientcredentialWIFI_SSID (when using Wi-Fi)  

→ The SSID of the access point to connect to.  
 clientcredentialWIFI_PASSWORD (when using Wi-Fi)  

→ The password of the access point to connect to. 
(Makes sure to enclose the above macro definitions in quotes (" ") as shown in the figure below. 

 
Note: The Wi-Fi encryption standard listed in 2.1, Hardware Configuration, is the default. To use a 

different encryption standard you will need to define clientcredentialWIFI_SECURITY as well. 

 

Figure 4.7   aws_clientcredential.h 
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7. Double-click ${base_folder}\tools\certificate_configuration\CertificateConfigurator.html. 

 

Figure 4.8   Opening CertificateConfigurator.html 
 
8. Specify the thing certificate and private key files downloaded as described in 4.1, AWS Preparation, then 

click Generate and save aws_clientcredential_key.h. 
 xxxxxx-certificate.pem.crt (thing certificate) 
 xxxxxx-private.pem.key (private key) 

 

Figure 4.9   Certificate Configuration Tool 
 
9. Overwrite the file ${base_folder}\demos\common\include\aws_clientcredential_key.h with the newly 

generated aws_clientcredential_key.h file. 

 

Figure 4.10   Overwriting aws_clientcredential_key.h 
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10. Select Project → Build All and confirm that 0 errors are reported. 
 

Note: Make sure to clean the project before building it for the first time. If a demo build error occurs after 
the initial build, clean the project again and then build it.  

 

Figure 4.11   Project → Build All → 0 errors 
 
To check the connection to AWS, perform the steps described in section 2, Confirming the Connection to 
AWS, in the reference document Troubleshooting when Using Amazon Web Services. 
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5. Shadow Service 
This section describes how to use the AWS IoT Core shadow service to control an edge device (RX65N 
Cloud Kit) from the cloud. 

The shadow service can be used not only to collect data from edge devices, but also to control edge devices 
from the cloud. By controlling the product remotely it is possible to realize a variety of application requests. 

The sample code performs operations to switch LED control in response to data obtained about the LEDs 
and sensors. 

 

5.1 Device Properties 
The table below lists the device properties used by the demo. 

 
Table 5.1   Device Properties 

Property Status Operation 
“LEDControl” “LED_ON” LED1 (red) and LED2 (red) on the RX65N Cloud Kit top board 

are on. 
“LED_OFF” LED1 (red) and LED2 (red) on the RX65N Cloud Kit top board 

are off. 
“LED_LIGHT” The light sensor value is 500 or greater: LED1 (red) and LED2 

(red) off. 
The light sensor value is 100 or greater but less than 500: 
LED1 (red) on, LED2 (red) off. 
The light sensor value is less than 100: LED1 (red) and LED2 
(red) on. 

“LED_TEMP” The temperature sensor value is 30 or less: LED1 (red) and 
LED2 (red) off. 
The temperature sensor value is greater than 30 but no more 
than 40: LED1 (red) on, LED2 (red) off. 
The temperature sensor value is greater than 40: LED1 (red) 
and LED2 (red) on. 

“SWVersion” “VER_x.y.z”  
(Note: x, y, and 
z represent 
user-defined 
positive integer 
values.) 

The software version is changed to x.y.z. (The value in 
aws_application_version.h is used initially.) 
When the software version changes, LED1 (red) and LED2 
(red) flash for 10 seconds. 

“IPAddress” None Indicates the IP address.  
(Uses the value of R_WIFI_SX_ULPGN_GetIpAddress.) 

“sensorDataUpdateOn” “UpdateOn” The value obtained from the light sensor is uploaded. 
“UpdateOff” A fixed value of 0 is uploaded. 
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5.2 Using the Shadow Service 
The procedure for manipulating shadows is described below. 

 
1.  Perform all the steps listed in 4, Connecting to AWS. 
 
2.  On the AWS Management Console select Services → All services → IoT → IoT Core, then click Test 

→ Subscribe to a topic, enter # in the topic filter field, and click the Subscribe button. 

 

Figure 5.1   Subscribing to a Topic 
 
3. Click the Debug icon in the upper left corner of the e2 studio window. 

 

Figure 5.2   Debug 
 
4. A message appears asking you to confirm that you wish to switch to the Debug perspective; click the 

Switch button.  

 

Figure 5.3   Confirm Perspective Switch 
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5. Click the Resume icon. After a short time execution pauses at the main function; click the Resume icon 
again. 

 

Figure 5.4   Running the Demo Program 
 
6. Return to the AWS Management Console, click Test → Publish to a topic, and enter the following code 

as the topic name. 
 

Note: In place of xxxx, enter the name of the thing registered as described in 4.1, AWS Preparation. 
$aws/things/xxxx/shadow/update 

Figure 5.5   Topic Name 
 
7. Copy the following lines of code and paste them into the message payload field. 

(In this example the setting LED_ON is used, but you can make settings to tailor the operation to match 
the statuses listed in the Device Properties table.) 
{ 

    "state": { 

        "desired": { 

            "LEDControl": "LED_ON", 

            "SWVersion": "VER_0.9.3", 

            "SensorDataUpdateOn": "UpdateOn" 

        } 

    } 

} 

Figure 5.6   Message Payload 
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8. Click Publish and confirm that LED1 and LED2 on the RX65N Cloud Kit top board turn on. 

 

Figure 5.7   Publishing a Topic 
 

 

Figure 5.8   RX65N Cloud Kit LED1 and LED2 On 
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6. Elasticsearch 
This section describes using the Elasticsearch service of AWS to visualize data obtained from the sensor 
module mounted on the RX65N Cloud Kit board. 

Fees are incurred when using the Amazon Elasticsearch service. Make sure to delete your Elasticsearch 
domain after you finish using the demo program. 
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6.1 Elasticsearch Preparation 
Follow the steps below to prepare Elasticsearch for the demo program. 

 
Follow the steps below to set up Elasticsearch.  

1. On the AWS Management Console, click Elasticsearch Service under All services → Analytics. 

 

Figure 6.1   Selecting Elasticsearch Service 
 
2. Click Create a new domain. 

 

Figure 6.2   Create a new domain 
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3. Select the radio button next to Development and testing and set Elasticsearch version to 7.1. Then 
click Next. 

 

Figure 6.3   Choose deployment type 

 
4. Enter an Elasticsearch domain name and change the Instance type selection to 

t2.small.elasticsearch, then scroll down. 

 

Figure 6.4   Configure domain 
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5. Click Next. 

 

Figure 6.5   Configure domain, Next 
 
6. Select Public access, then scroll down. 

 

Figure 6.6   Network configuration  
 
7. Set Domain access policy to Custom access policy and select IPv4 address. Enter the global IP 

address of your PC and select Allow. 
 

Note: Search for “check global IP address” on the internet to find out how to determine the global IP 
address of your PC. 

 

Figure 6.7   Access policy 
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8. Click Next. 

 

Figure 6.8   Access policy, Next 
 
9. On the Add tags page, click Next without doing anything. 

 

Figure 6.9   Do Nothing and Click Next 

 
10. On the Review page, double-check your configuration and choose Confirm. 

 

Figure 6.10   After Clicking Next, Confirm 
 



RX65N Group Visualizing and Controlling Sensor Information Using Amazon Web Services  
with RX65N Cloud Kit and FreeRTOS 

R20AN0623EJ0100  Rev.1.00  Page 24 of 43 
Jun.23.21  

11. Your Elasticsearch domain is created. Stand by until Domain status changes to Active. 
 

Note: It may take one to two hours before Domain status changes to Active. 

 

Figure 6.11   Stand by Until Domain status Changes to Active 
 
12. Once Domain status changes to Active, access the Kibana URL. 

 

Figure 6.12   Domain status: Active 
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6.2 Kibana Preparation 
Follow the steps below to prepare Kibana for the demo program. 

 
1. Click Explore on my own. 

 

Figure 6.13   Explore on my own 
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2. On the menu bar on the left, click the Dev Tools icon. 

 

Figure 6.14   Dev Tools 
 
3. Click Get to work. 

 

Figure 6.15   Get to work 
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4. In the console window on the left, enter the following code. 
PUT /sensor?include_type_name=true 

{ 

  "mappings": { 

    "sensor": { 

      "properties": { 

        "timestamp": { 

          "type": "long", 

          "copy_to": "datetime" 

        }, 

        "datetime": { 

          "type": "date", 

          "store": true 

        }, 

        "temperature": { 

          "type": "long" 

        }, 

        "humidity": { 

          "type": "long" 

        } 

      } 

    } 

  } 

} 

Figure 6.16   Code Entered in Console Window 
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5. Click the click to send request icon in the upper right corner of the console. 

 

Figure 6.17   click to send request 
 
6. Confirm that the following response is returned. 
{ 

  "acknowledged" : true, 

  "shards_acknowledged" : true, 

  "index" : "sensor" 

} 

Figure 6.18   Confirming Response 
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6.3 IoT Rule Preparation 
Follow the steps below to prepare an IoT rule for the demo program. 

 
1. Go to the IoT Core control panel, select Act → Rules, and click Create a rule. 

 

Figure 6.19   Create a rule 
 
2. Enter a name for the rule, then enter the following code under Rule query statement. 

SELECT *, timestamp() as timestamp FROM 'iotdemo/topic/sensor' 
 

Note: After entering the rule query statement make sure to enter a line break. 

 

Figure 6.20   Entering Code 
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3. Click Add action. 

 

Figure 6.21   Add action 
 
4. Select Send a message to the Amazon Elasticsearch Service and click Configure action. 

 

Figure 6.22   Configure action 
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5. For Domain name enter the domain name created as described in 6.1, Elasticsearch Preparation, for ID 
enter ${newuuid()}, for Index enter sensor, and for Type enter sensor. 

 

Figure 6.23   Domain name, ID, Index, and Type Settings 
 
6. Click Create a new role, then enter the name of the role and click Create role. 

 

Figure 6.24   Create role 
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7. Confirm that the role you created is selected, then click Add action. 

 

Figure 6.25   Add action 
 
8. Confirm that the action was added, then click Create rule. 

 

Figure 6.26   Create rule 
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6.4 Running the Demo Program 
Follow the steps below to run the demo program. 
 
1. Click the Debug button to connect to RX65N Cloud Kit. 

 

Figure 6.27   Debug 
 
2. Click the Resume button. After a short time execution pauses at the main function; click the Resume 

button again.  

 

Figure 6.28   Running the Demo Program 
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6.5 Visualizing Sensor Information with Kibana 
Follow the steps below to use Kibana to visualize sensor information. 

 
1. Go to Kibana, and click the Management icon in the menu at left. 

 

Figure 6.29   Kibana Setup 
 
2. Click Index Patterns and for Index pattern enter sensor, then click > Next step. 

 

Figure 6.30   Define index pattern 
 



RX65N Group Visualizing and Controlling Sensor Information Using Amazon Web Services  
with RX65N Cloud Kit and FreeRTOS 

R20AN0623EJ0100  Rev.1.00  Page 35 of 43 
Jun.23.21  

3. For Time Filter field name select datetime, then click Create index pattern. 

 

Figure 6.31   Configure settings 
 
4. Click the Visualize icon in the menu at left. 

 

Figure 6.32   Visualize 
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5. Click Create a visualization. 

 

Figure 6.33   Create a visualization 
 
6. Click the Line icon. 

 

Figure 6.34   Line 
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7.Click sensor. 

 

Figure 6.35   New Line / Choose a source 
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8. Click the calendar icon at the upper right, set Refresh every to 5 seconds, and click Start. 

 

Figure 6.36   Refresh every Setting 
 
9. For Metrics, under Y-Axis set Aggregation to Average and Field to light. 

 

Figure 6.37   Metrics Settings 
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10. For Buckets, under X-Axis set Aggregation to Date Histogram, Field to datetime, and Interval to 
Second. 

 

Figure 6.38   X-Axis Settings 
 
11. Click the Apply changes icon. 

 

Figure 6.39   Apply changes 
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12. On the graph of sensor data, confirm that the values change when the brightness changes.  
(The line on the graph should move downward when you cover the board with your hand and move 
upward when more light strikes the board.) 
A visualization of light sensor information is shown below. 

 

Figure 6.40   Visualization of Light Sensor Information 
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6.6 Important Note after Running Demo Program 
Fees are incurred when are using the Amazon Elasticsearch Service. 

Make sure to delete your Elasticsearch domain after you finish using the demo program. 

 

Figure 6.41   Don’t Forget to Delete Your Elasticsearch Domain! 
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7. Websites and Support 
AWS Amazon FreeRTOS forum: http://forums.aws.amazon.com 
Renesas Amazon FreeRTOS GitHub: https://github.com/renesas/amazon-freertos 

 
  

http://forums.aws.amazon.com/
https://github.com/renesas/amazon-freertos
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 
2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 
3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 
4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 
5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 
6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 
7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 
8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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Notice 
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products 

and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your 
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use 
of these circuits, software, or information. 

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, 
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this 
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples. 

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics 
or others. 

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, 
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required. 

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for 
each Renesas Electronics product depends on the product’s quality grade, as indicated below. 
 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 
 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 
Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space 
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics 
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product 
that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics 
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but 
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS 
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING 
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, 
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND 
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT 
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH 
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. 

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas 
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such 
specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are 
responsible for evaluating the safety of the final products or systems manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 
with applicable laws and regulations. 

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 
14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 
subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.  
(Rev.5.0-1  October 2020) 

 
Corporate Headquarters  Contact information 
TOYOSU FORESIA, 3-2-24 Toyosu, 
Koto-ku, Tokyo 135-0061, Japan 
www.renesas.com 

 For further information on a product, technology, the most up-to-date 
version of a document, or your nearest sales office, please visit: 
www.renesas.com/contact/. 

Trademarks   
Renesas and the Renesas logo are trademarks of Renesas Electronics 
Corporation. All trademarks and registered trademarks are the property 
of their respective owners. 
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